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INTRODUCTION

This manual is for the Cascade 4-Point Force Distribution 
Tester.  Contents include trolley Installation and setup, 
measuring clamp force, display configuration, reviewing 
recorded data and parts.

CAUTION – A statement preceded by CAUTION is 
information that should be acted upon to prevent  
machine damage.

IMPORTANT – A statement preceded by IMPORTANT is 
information that possesses special significance.

NOTE – A statement preceded by NOTE is information that 
is handy to know and may make the job easier.

Special Definitions
The statements shown appear throughout this manual 
where special emphasis is required.  Read all WARNINGS 
and CAUTIONS before proceeding with any work.  
Statements labeled IMPORTANT and NOTE are provided 
as additional information of special significance or to make 
the job easier.

WARNING – A statement preceded by  
WARNING is information that should be 
acted upon to prevent bodily injury.  A 
WARNING is always inside a ruled box.

WARNING: When operating the attachment 
and 4-Point Force Distribution Tester, verify 
that all personnel are clear of the 4-Point 
Force Distribution Tester prior to clamping 
on the spindles.IMPORTANT: For service, technical and software 

questions about the display, contact the service 
support department of Antibus Scales & Systems, Inc. 
(574) 233-3160 (US only).  International countries should 
contact a local Rice Lake® Weighing Systems dealer.

AC3224.eps



16902907 16902907

SETUP

Start Data Setup

4 POINT CLAMP FORCE DISTRIBUTION TESTER
www.cascorp.com
1-800-CASCADE

07/12/2015 08:00AM SCALE #1

Clamp Home

START

ID Number:

Pressure:

ID

07/12/2015 08:00AM SCALE #1
Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

PEAK
Lower Front

Zero Print Save New Home

612.0
156.8

25.62 %
154.2

25.20 %

150.8
24.64 %

150.2
24.54 %

PSI
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Quick System Check
1	 Plug the display's power connector into a 120V power 

source.

2	 Once the display shows the Home screen, press the 
button under "Start" menu option.

3	 Then press the button under "Clamp" menu option.

4	 Once the display shows the Clamp screen, press the 
button on the "Zero" menu option.

5	 Clamp on the trolley's spindle pads. 

6	 The display should show four clamp force values and 
four percentages.  The display is working properly.

7	 Release and OPEN the clamp arms. 

8	 Press the button under the "Home" menu option.

5

2

6

3

4 8
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SETUP

Verify Spindle Length
Perform the following for each spindle:

1	 Place the spindle in the cradle located on the side of the 
trolley, as shown.  Use the trolley width to set the overall 
length of the spindle.  Adjust the length at the spindle 
pads.

2	 Turn on the display.  Adjust the spindle to show a preload 
of 5 ft-lbs. (6.8 Nm) on the display.  Tighten locknuts.

3	 Tap the spindle out to remove.

CAUTION: Failure to set the overall length of each spindle 
assembly to same length, will result in inaccurate clamp 
force results.

AC3232.eps

Adjust Adjust
Cradle

Cradle

Spindle

Adjust Spindle to Trolley width
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SETUP
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PRINTUNITS

Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

PEAK
Lower Front

Zero Print Save New Home

AC2960.eps

Adjust Spindle Supports
IMPORTANT: Perform this procedure with the aid of a 
Cascade sales representative to determine the optimal 
location of spindle pads for proper clamp force distribution.

1	 Position the trolley between the carton clamp contact 
pad.

3

3	 From the Clamp screen on the display, press the button 
on the "Zero" menu option.

Clamp 
Screen

2	 If required, adjust the supports to align the spindle 
pads to four locations on each of the carton clamp 
contact pads.  The four locations on the contact pad, 
are determined by the type of products being handled.  
Contact a Cascade sales representative to determine 
optimal pad and spindle positioning.

2Upper 
Front

Rail Adjusts
Lower 
Front

Upper Back

Lower Back

AC3226.eps
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Mark around 
each spindle 
(4 places on 
each pad)

6	 Use a contrasting permanent marking device to outline 
each spindle pad on the contact pads.

5	 Refer to the display's four percentages.  Verify that 
the clamp force distribution is within the desired 
percentages and tolerances.

If the tolerance difference is greater than allowable 
tolerance difference, the carton clamp pads require 
shimming.  Refer to installation instructions for the 
carton clamp to shim:

•	 D-Series Carton Clamp Installation Instructions, 
Part No. 670488

•	 G-Series Carton Clamp Installation Instructions, 
Part No. 6033701.

•	 J-Series Carton Clamp Installation Instructions, 
Part No. 6871082.

PRINTUNITS

Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

PEAK
Lower Front

Zero Print Save New Home

612.0
156.8

25.62 %
154.2

25.20 %

150.8
24.64 %

150.2
24.54 %
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Upper Back

Upper Back

Upper Front

Upper Front

Lower Front

Lower Front

Lower Back

Lower Back

4	 Clamp on the trolley's spindle pads.

4

6
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MEASURING CLAMP FORCE

Measure Peak Clamp Force
Peak Force is the maximum measured force applied to the 
spindles.  Also, the display will show the distribution of the 
force applied to each spindle's load cell. 

2	 From the Home Screen, press the button under "Start" 
menu option.

1	 Align the attachment pads with the trolley spindle pads.

8	 Clamp on the spindle pads.  The display will show force 
values and clamp force distribution percentages.

9	 Release the spindle pads.

5	 Verify that the screen shows "PEAK".  Refer to page 9, 
Step 2 to toggle between "PEAK" and "LIVE".

6	 If required, zero the loads cells.

7	 If required, change the units, lbf (pounds-force) or 
N (newtons).  Refer to Display Configuration, "Start 
Screen" for details, page 9.

3	 If required, enter the truck identification and pressure 
in the ID screen.  Refer to Display Configuration, "Start 
Screen" for details, page 9.

4	 Press the menu selection button under "Clamp" menu 
option.

8
10	 Information shown on the display can be saved and/or 

printed.  Refer to Display Configuration, "Start Screen" 
for details, page 9.

Start Data Setup

4 POINT CLAMP FORCE DISTRIBUTION TESTER
www.cascorp.com
1-800-CASCADE

07/12/2015 08:00AM SCALE #1

Clamp Home

START

ID Number:

Pressure:

ID

PSI

PRINTUNITS

Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

PEAK
Lower Front

Zero Print Save New Home

612.0
156.8

25.62 %
154.2

25.20 %

150.8
24.64 %

150.2
24.54 %
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2

3
4

5
6 7

If required

If required
If required

The following section covers the general procedure for measuring the clamp force of a carton clamp attachment. For 
further details on a specific step of the procedure, refer to Display Configuration section, pages 7-12.  There are two 
methods of measuring, peak clamp force (procedure below) or live clamp force (procedure on the following page).  Peak 
force is the highest clamp force measured. While in peak mode, the percentage distribution will also show.  Live force is the 
real time clamp force measured. 

AC3230.eps
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MEASURING CLAMP FORCE

Measure Live Clamp Force
Live clamp force is the real time (current moment in time) 
measured force applied to the spindles.

IMPORTANT: When measuring clamp force in "LIVE" 
mode, the data can not be saved or printed.

4	 Verify that the screen shows "LIVE".  Refer to page 9, 
Step 2 to toggle between "PEAK" and "LIVE".

5	 If required, zero the loads cells.

6	 If required, change the units, lbf (pounds-force) or 
N (newtons).  Refer to Display Configuration, "Start 
Screen" for details, page 9.

7	 Clamp on the spindle pads.  The display will show force 
values.  Clamp force for each spindle and clamp force 
will show on the display.

8	 Release the spindle pads.

3	 Press the button under "Clamp" menu option.

2

3

4
5 6

If required

If required

7

2	 From the Home Screen, press the button under "Start" 
menu option.

1	 Align the attachment pads with the trolley spindle pads.
Start Data Setup

4 POINT CLAMP FORCE DISTRIBUTION TESTER
www.cascorp.com
1-800-CASCADE

PRINTUNITS

Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

LIVE
Lower Front

Zero Print Save New Home

510.2
129.1128.6

125.8126.7

07/12/2015 08:00AM SCALE #1

Clamp Home

START

ID Number:

Pressure:

ID

PSI
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DISPLAY CONFIGURATION

Accessing the Home Screen
1	 Plug the display power cord into a 120V power source.

NOTE: If equipped with printer, plug the printer's power 
cord into a power source.

2	 Wait for the screen to load to the Home screen.

3	 The Home screen will show.  Press a menu option 
button:

•	 Start (A) – Goes to the Start screen. This screen is for 
obtaining clamp force values.  Refer to page 9.

OR

•	 Data (B) – Goes to the Data screen. This screen 
allows the user to view data stored or download 
stored data.  Refer to page 10.

OR

•	 Setup (C) – Goes to the Setup screen.  This screen 
has options for changing data/time, create/change 
password, change the screen's contrast and adjust 
the threshold force value.  Refer to page 11.

NOTE: Refer to the following page for the display's 
layout.

Display Buttons
The following is the basic layout of the display for reference:

PRINTUNITS

Start Data Setup

4 POINT CLAMP FORCE DISTRIBUTION TESTER
www.cascorp.com
1-800-CASCADE

AC2968.eps

A B C

Home Screen

2

3

A Text Box

B Display Screen

C
Left and right arrows toggle between PEAK and 
LIVE (Clamp Screen)

D Accesses Character Menu Box

E Enter button – Accepts a value

F Menu Options

G Zeros clamp force (Clamp Screen)

H Toggle between units – Imperial and Metric

I NOTE: Buttons are not functional

J Buttons for selecting menu options

K Decimal button

L Numeric buttons

M CLR button – backspace when changing a value

PRINTUNITS

07/12/2015 SCALE #108:00AM

AC2967.eps

A B C D E

F G H I J K L M
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DISPLAY CONFIGURATION

PRINTUNITS

Start Data Setup

4 POINT CLAMP FORCE DISTRIBUTION TESTER
www.cascorp.com
1-800-CASCADE

AC2969.eps

ID

Clamp

Zero

Page Up

Print

Page Down

Save

Print

New

Delete

Home

Home

Home

USB

View

Home

Date/Time

Password

Contrast

Threshold
Force

Home

Enter ID 
Number

Returns to
Home Screen

Returns to
Home Screen

Returns to
Home Screen

Choose:
Save Configuration 
(*.920) Enter Time

Enter Date

Create/Change
Password for
Setup Screen

Change Display's 
Contrast

Enter Threshold 
Force

Save All Databases 
(*.db)

Drive

No Device

Enter Delivered 
Truck Pressure

Start

Home Screen

Setup
Data

Navigation Tree
From the home screen (shown), 
pressing one of the buttons, will go 
to following screens:

NOTE: For detailed information, 
refer to the following pages.
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DISPLAY CONFIGURATION

PRINTUNITS

START

ID Number:

Pressure:

Clamp HomeID

PSI

PRINTUNITS

07/12/2015 08:00AM SCALE #1

START

ID Number:

Pressure:

Cancel EndHome

ENTER TRUCK ID
Truck123=>

PRINTUNITS

07/12/2015 08:00AM SCALE #1
Upper Back

Lower Back

Upper FrontPressure
Truck ID

Total
lb

PEAK0

0

0

0

Lower Front

Zero Print Save New Home

PSI

AC2970.eps1
2

3

A

A,B

A,B

A

B C D E F

Accesses the 
Character 
Menu Box

Accepts 
the value

Toggle 
"Peak"/"Live"

Moves the 
cursor to 
the far left

Moves the 
cursor to 
the far right

Clears the 
highlighted 
character in 
the text entry 
box

Cancels the 
action and 
returns the 
main menu

Start Screen
After the "Start" menu option button is pressed, the Start 
screen will show.  From the Start screen:

1	 When the "ID" menu option button is pressed, the screen 
goes to the ID screen. The screen will prompt:

A	Enter the truck identification  To enter the truck 
identification, use the numeric buttons and character 
menu box.  To accept the truck identification, press 
the "enter" button.

NOTE: Refer to Appendix, "Letters and Special 
Characters", page 24 for more detail. 

B	Enter the pressure value. Use the numeric buttons to 
enter a value. To accept the value, press the "enter" 
button.

C	The screen will then return to the Start screen.

2	 When the "Clamp" menu option button is pressed, the 
screen goes to the Clamp screen. The following options 
are available:

•	 Use the left and right arrow button to toggle between 
"Peak" and "Live". (A)

•	 "Zero" menu option button (B) – Zeroes residual or 
unladen force values appearing on the display prior 
to clamping.

•	 "Print" menu option button (C) – If equipped with the 
printer, the data will print out.  The ticket will list the 
truck identification, pressure, peak clamp forces for 
each load cell, total clamp force, date and time.

2	  (continued)

•	 "Save" menu option button (D) – The peak value is 
saved to the display's internal memory.

•	 "New" menu option button (E) –  Returns to the Start 
screen.

•	 "Home" menu option button (F) –  Returns to the 
Home screen.

3	 When the "Home" menu option button is pressed, the 
screen returns to the Home screen.

Start Screen

ID Screen Clamp Screen
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DISPLAY CONFIGURATION

07/12/2015 08:00AM SCALE #1

View Home

DATA - USB

USB

Insert USB Drive and Press USB Key to Download
Press View to View Print and Delete Records

07/12/2015 08:00AM SCALE #1

Print DeletePage DownPage Up

Col PSI UB UF LB LFID Date/Time
1 T1 1350 0 0 0

Totals

2
3
4
5
6

13-09-19 07:58:20 AM
T1 1365 0 0 013-09-18 05:00:58 PM
T1 1507 0 0 013-09-18 04:50:32 PM
T1 1421 0 0 013-09-18 04:10:54 PM
T1 2032 -1 2 113-09-18 03:15:18 PM
T1

600
600

1000
700

1500
600 1275 -1 0 013-09-18 02:42:10 PM

3566 3180 3326 361613-09-19 07:59:58 AM

Home

07/12/2015 08:00AM SCALE #1

DATA - USB

Insert USB Drive and Press USB Key to Download
Press View to View Print and Delete RecordsSave Configuration (*.920)

Save All Databases (*.db)
Drive

No Device

AC2971.eps

1 2

3

AA

AB

B C D E
Selected position 
is highlighted

Data Screen
All clamp force data is stored in a database table format 
and can be downloaded to a USB flash drive.  Data can 
also be viewed on the display screen.

IMPORTANT: Prior to pressing the "USB" menu option 
button, install a USB flash drive into the display's USB port.

After the "Data" menu option button is pressed, the Data 
screen will show.  From the Data screen:

1	 When the "USB" menu option button is pressed, the 
screen goes to the USB screen. The screen will prompt:

NOTE: If a USB flash drive is not installed, the text entry 
box will show, "No Device available".

A	Use the arrow buttons to highlight "Save All 
Databases (*.db)". 

B	Press the "enter" button to save the database files to 
the USB flash drive.

2	 When the "View" menu option button is pressed, the 
screen goes to the View screen. The following options 
are available:

•	 "Page Up" menu option button (A) – The previous 
table page will show.

•	 "Page Down" menu option button (B) –  The next 
table page will show.

2	 (continued)

•	 "Print" menu option button (C) –  Allows for one row 
to be printed.  The screen will prompt for the row 
number.  Press the "enter" button to accept entered 
row number and create the printout.

•	 "Delete" menu option button (D) – Deletes all data 
stored in the table.

•	 "Home" menu option button (E) –  Returns to the 
Home screen.

3	 When the "Home" menu option button is pressed, the 
screen returns to the Home screen.

USB Screen View Screen

Data Screen
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DISPLAY CONFIGURATION

PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Contrast HomeDate/Time Setup
Password

Threshold
Force

PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Cancel EndHome

EnterTime
HHMMSS

PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Cancel EndHome

ENTER NEW PASSWORD
=>

AC2972.eps

Setup Screen
The Setup Screen contains five menu options.  Four options 
change the following settings: Date and time, password 
enabled Setup screen, screen contrast and threshold force.  
The fifth option returns to the Home screen.

After the "Setup" menu option button is pressed, the Setup 
screen will show. From the Setup screen:

1	 When the "Date/Time" menu option button is pressed, 
the following steps will show in the text entry box:

A	Use the numeric buttons to change the time, in 
HHMMSS format.

B	To accept the time value, press the "enter" button.

C	Use the numeric buttons to change the date, in 
MMDDYY format.

D	To accept the time value, press the "enter" button.

E	The screen returns to the main Setup screen.
2	 When the "Password" menu option button is pressed, 

the  following steps will show in the text entry box:

A	To create/change the password.  Use the numeric 
buttons and character menu box.  

NOTE: Refer to Appendix, "Letters and Special 
Characters", page 24 for more detail.

B	To accept the new/changed password, press the 
"enter" button.

C	The screen returns to the main Setup screen.

1 2

B,D

A,C
A

A

B
Accesses the 
Character 
Menu Box

Accepts 
the value

Moves the 
cursor to 
the far left

Moves the 
cursor to 
the far left

Text Entry Box Text Entry Box

Moves the 
cursor to 
the far right

Moves the 
cursor to 
the far right

Clears the 
highlighted 
character in 
the text entry 
box

Clears the 
highlighted 
character in 
the text entry 
box

Cancels the 
action and 
returns to 
main menu

Cancels the 
action and 
returns to 
main menu

Setup Screen - Change Date/Time Setup Screen - Change Password

Setup Screen

Button Menu Options continued on the next page
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DISPLAY CONFIGURATION

PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Contrast HomeDate/Time Setup
Password

Threshold
Force

PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Cancel EndHome

Contrast (0-127)=>

PRINTUNITS

07/12/2015 08:00AM SCALE #1

SETUP

Gross

Threshold: 10 lb

lb

Total
#1

Cancel EndHome

ENTER THRESHOLD WT
=> 10

AC2973.eps

Setup Screen (continued)
After the "Setup" menu option button is pressed, the Setup 
screen will show. From the Setup screen:

3	 When the "Contrast" menu option button is pressed, the 
screen will prompt:

A	Use the numeric buttons to enter a value within the 
range of 0 to 127.

B	To accept the contrast value, press the "enter" button.

C	The screen returns to the main Setup screen.

4	 When the "Threshold Force" menu option button is 
pressed, the screen will prompt:

A	Use the numeric buttons to change the Threshold 
Force value.  This is the minimal value that will 
produce a response when a force is being applied to 
the spindles.  The default value is set to 10.

B	To accept the threshold force value, press the "enter" 
button.

C	The screen returns to the main Setup screen.

5	 When the "Home" menu option button is pressed, the 
screen returns to the Home screen.

3 4

5

B B

Setup Screen - Change Contrast Setup Screen - Change Threshold Force

Setup Screen

Moves the 
cursor to 
the far left

Moves the 
cursor to 
the far left

Text Entry Box Text Entry Box

Moves the 
cursor to 
the far right

Moves the 
cursor to 
the far right

Clears the 
highlighted 
character in 
the text entry 
box

Clears the 
highlighted 
character in 
the text entry 
box

Cancels the 
action and 
returns the 
main menu

Cancels the 
action and 
returns the 
main menu

AA
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The original file saved to the USB flash drive is a database 
file (file extension: ".DB").  If a database program is not 
available to view, the file can be opened by performing the 
following procedure.

NOTE: The following procedure uses Excel 2010.  Other 
similar software may have a different procedure than the 
one shown below.

1	 Plug the USB flash drive into a computer USB port. 
Navigate to the root directory (top level) of the USB flash 
drive.

2	 Locate the file called "TRANSACT.DB".  Create a copy 
of the file on the USB flash drive or to a specified file 
location.

3	 Change the copied file's file extension from "DB" to "txt".  
Example: TRANSACT.DB becomes TRANSACT.txt

12

5

67 8

4	 Launch Excel software.

5	 In the Excel menu, choose "File" and then "Open".

AC2737.eps

6	 In the "Open" dialog box, change the filter to "All Files 
(*.*)".

7	 Choose the file "TRANSACT.txt" from the file location the 
file was copied to (Step 2).

8	 Click the "Open" button.

AC2975.eps

AC2976.eps
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	10	 Choose the "Finish" button.  The file will open.

	11	 Save the file as an Excel document (file type ".xlsx").

	12	 The file is ready to review.

	 9	 A "Text Important Wizard" dialog box will 
appear.  Verify that the following options 
are selected:

A	Original Data Type: Delimited

B	Delimiters: check "Other", add "|" in 
the text box next to the check box.

NOTE: The character "|" (vertical 
bar), can be found on the keyboard 
above the backslash (reverse 
solidus).  To add the character press 
the "shift" key + "\" key.

C	Column Data Format: "General"

A

B

C

9

10

12A Upper Back Clamp Force

B Upper Front Clamp Force

C Lower Back Clamp Force

D Lower Front Clamp Force

E Total

F Date and Time

G Pressure Type

H Truck ID

A D F H

B C E G

AC2978.eps

DATA
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8

9

!

0

2 7
6

3

4

1
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5

4-Point Force Distribution Tester

REF QTY PART NO. DESCRIPTION

6841756 4-Point Force Distribution Tester ◆
6859239 Printer and Mounting Group ▲

1 1 6886768 Trolly Assembly l
2 1 6887193 Display ▼
3 4 6854155 Spindle/Pad Assembly
4 1 6894510 Gauge
5 ■ 6868083 Hook and Loop Kit ❍

u	� Includes items 1–7.
▲	� Includes items 8–11.
l	� See Trolly Assembly page for parts breakdown.
▼	� Includes items 6 and 7.
■	� Quantity as required.

REF QTY PART NO. DESCRIPTION

6 1 6887156 Display Bracket
7 4 1880155 Capscrew, M6 x 12
8 1 6842181 Printer
9 1 6842218 Printer Mounting Bracket
10 2 6889110 Self Tapping Capscrew, #5 x .5
11 2 1880248 Capscrew, M6 x16

❍	 Kit contains 15 ft. (4.5 m) of hook and loop tie and 10 buckles. 
The kit makes 8 to 10 ties.

Reference: 4-Point Force Distribution Tester with Printer, part no. 
6842303.

NOTE: Install paper in the 
direction as shown.

Printer Paper Replacement
Use Epson Thermal Paper 
Manufacturer's Part No.: NTP080-80
Paper Width: 3.15 in. (80 mm)
Maximum Diameter: 3.27 in. (83 mm)
Spool Diameter: 0.47 in. (12 mm) ID
	 0.71 in. (18 mm) OD
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PARTS

Trolley Assembly
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PARTS

Trolley Assembly

REF QTY PART NO. DESCRIPTION

6886768 Trolley Assembly
1 6886959 Mounting Plate Assembly ▲
1 6886960 Upper Tube Assembly ▼
3 6886908 Tube Assembly ●
2 6886935 Tube Assembly ■

1 1 6886826 Bottom Rail Assembly ◆
2 1 6889286 Upper Cradle Assembly ❍
3 2 6889187 Handle
4 1 6886948 Leg Assembly, Left Front ❏
5 1 6886944 Leg Assembly, Left Rear ❏
6 1 6886947 Leg Assembly, Right Front ❏
7 1 6886937 Leg Assembly, Right Rear ❏
8 1 ✖ 6886786 Mounting Plate
9 2 ✖ 6030448 Capscrew, M8 x 55
10 1 ✖ 6886766 Tube, 18 in.
11 2 ✖ 6886748 Tube Insert
12 2 ✖ 221494 Washer, M8
13 1 6886849 Rail Adjuster Assembly ❖
14 2 ✖ 6886783 Corner Bracket
15 2 ✖ 767414 Nut, M8
16 2 ✖ 6886882 Capscrew, M8 x 55
17 2 ✖ 221494 Washer, M8
18 2 ✖ 6886748 Tube Insert
19 1 ✖ 6886763 Tube, 48 in.
20 1 ✖ 6886766 Tube, 18 in.

▲	� Includes items 8-12.
▼	� Includes items 23-28.
●	� Includes items 14-19.
■	� Includes items 20-22.
u	� See Rail Assembly page for parts breakdown.
❍	� See Cradle Assembly page for parts breakdown.
❑	� See Leg Assembly page for parts breakdown.
❖	� See Rail Adjuster Assembly page for parts breakdown.
✖	� Quantity for one assembly.

REF QTY PART NO. DESCRIPTION

21 2 ✖ 6886784 Tube Insert
22 2 ✖ 689151 Capscrew, M8 x 20
23 1 ✖ 6886766 Tube, 18 in.
24 2 ✖ 6886785 Bracket
25 4 ✖ 767414 Nut, M8
26 4 ✖ 6030448 Capscrew, M8 x 55
27 4 ✖ 221494 Washer, M8
28 2 ✖ 6886748 Tube Insert
29 6 767414 Nut, M8
30 2 6002668 Capscrew, M8 x 20
31 2 1852657 Capscrew, M8 x 25
32 10 1852661 Capscrew, M8 x 50
33 4 6030448 Capscrew, M8 x 55
34 2 6030449 Capscrew, M8 x 60
35 2 6819533 Capscrew, M8 x 65
36 4 689151 Capscrew, M8 x 20
37 6 6886882 Capscrew, M8 x 55
38 2 6886981 Capscrew, M6 x 45
39 2 6886880 Capscrew, M6 x 50
40 4 6886803 T-Nut
41 6 221494 Washer, M8
42 4 6889308 Plastic Edge Trim, 1035 mm
43 4 6889311 Plastic Edge Trim, 1130 mm
44 2 6886793 Top Rail
45 2 6886767 Tube, 54 in.
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PARTS

REF QTY PART NO. DESCRIPTION

6854155 Swivel Pad Assembly
2 6854195 Swivel Pad Sub-Assembly ◆

1 2 6839315 Rod
2 2 5721 Jam Nut
3 2 6854149 Pin
4 2 768704 Capscrew, M1 25
5 2 6854158 Washer
6 1 6854545 Flange
7 1 6854165 Bearing
8 1 6854179 Retaining Ring

◆	 	Includes items 6-8.

Swivel Pad Assembly

6
7

8
3

2
1

AC3245.eps
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PARTS

Bottom Rail Assembly

REF QTY PART NO. DESCRIPTION

6886826 Bottom Rail Assembly
1 2 6886825 Bottom Rail
2 1 6889285 Cradle Assembly ■
3 1 6886813 End Bar
4 1 6886841 Nameplate
5 4 1880155 Capscrew, M6 x 12
6 4 6886747 Unibearing
7 2 6886981 Capscrew, M6 x 45
8 2 6886820 Anchor Fastener

■	 	See Cradle Assembly page for parts breakdown.

5

4

1

7

2

6

1

3

8

6
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PARTS

Cradle Assembly

REF QTY
LOWER

PART NO.
UPPER

PART NO. DESCRIPTION

6889285 6889286 Cradle Assembly
1 2 6886808 6886808 Cradle Assembly with Brake ■
2 2 6886837 6886811 Spacer Bar
3 4 202346 202346 Washer. M6
4 4 761170 761170 Capscrew, M6 x 20
5 1 6886745 6886745 Bearing
6 1 6886809 6886809 Cradle Bracket
7 2 6887052 6887052 Capscrew, M6 x 20
8 1 6886752 6886752 Knob
9 1 202346 202346 Washer, M6
10 1 6887076 6887076 Carriage Bolt

■	 	Includes items 5-10.

4
3
1

7
0
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8
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5
3
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PARTS

Front Leg Assembly
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REF QTY PART NO. DESCRIPTION

6886947 Leg Assembly, Right Front
6886948 Leg Assembly, Left Front

1 1 6886875 Cradle Bracket
2 1 6886751 Caster, Swivel
3 1 6886783 Corner Bracket
4 1 6886756 Tube, 45 in.
5 1 6886750 Tube Insert
6 1 6886748 Tube Insert
7 1 1852637 Capscrew, M8 x 12
8 1 689151 Capscrew, M8 x 20
9 2 6030448 Capscrew, M8 x 55
10 2 221494 Washer, M8
11 2 767414 Nut, M8
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PARTS

Rear Leg Assembly

AC3081.ai
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REF QTY PART NO. DESCRIPTION

6886937 Leg Assembly, Right Rear
6886944 Leg Assembly, Left Rear

1 1 6886787 Cradle Bracket
2 1 6886751 Caster, Swivel
3 1 6886783 Corner Bracket
4 1 6886756 Tube, 45 in.
5 1 6886750 Tube Insert
6 1 6886748 Tube Insert
7 1 1852637 Capscrew, M8 x 12
8 1 689151 Capscrew, M8 x 20
9 2 6030449 Capscrew, M8 x 60
10 2 221494 Washer, M8
11 2 767414 Nut, M8
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PARTS

Rail Adjuster Assembly
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REF QTY PART NO. DESCRIPTION

6886849 Rail Adjuster Assembly
1 2 6886851 Adjuster Rail
2 2 6886820 Anchor Fastener
3 4 6886884 Corner Bracket
4 2 6886883 Cradle Bracket
5 1 6886852 End Bar
6 2 6889113 End Cap
7 1 6889189 Handle
8 2 1852657 Capscrew, M8 x 25
9 6 6874680 Capscrew, M6 x 12
10 4 220436 Capscrew, M6 x 16
11 2 6886981 Capscrew, M6 x 45
12 4 6886803 T-Nut

NOTE: When installing Rail Adjuster Assembly into the trolley, 
remove items 6 and 9 prior to installation (or removal).  After the 
assembly is positioned in the trolley, reinstall items 6 and 9.
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APPENDIX

Refer to the following when text, special characters or 
numbers are required. 

1	 When text or special character(s) is required, press the 
"Up" arrow button to open the Character Menu Box.

2	 For each character position:

•	 Press a numeric button 

OR

•	 Use the arrow buttons to move the cursor to highlight 
a letter or special character and then press the 
"enter" button.

3	 When finished with entering numbers, letters and/or 
special characters, use the arrow buttons to move the 
cursor into the text entry box.

NOTE: Always verify that the cursor is not in the 
character menu box.  Pressing the "enter" button will 
add the highlighted character to the text entry box 
rather then accepting the entered text.

4	 Press the "enter" button to accept the value.

Indicates 
character 
position

Press the "UP" arrow to open 
the Character Menu Box

Moves the indicator 
to the first character 
in the text entry box

Moves the indicator 
to the last character 
in the text entry box

Cancels the 
function

Text Entry Box

Character 
Menu Box

Press the "enter" button 
to accept the text/special 
character.  The character 
will be added to the text 
entry box.

Use arrow buttons to highlight 
over a text or special character

Clears the 
indicated 
character

Press a numeric 
button to add a 
number to the text 
entry box

Cursor

Letters and Special Characters

PRINTUNITS
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Do you have questions you need 
answered right now?  Call your nearest Cascade Service Department.
Visit us online at www.cascorp.com

AMERICAS
Cascade Corporation
U.S. Headquarters
2201 NE 201st
Fairview, OR 97024-9718
Tel: 800-CASCADE (227-2233)
Fax: 888-329-8207

Cascade Canada Inc.
5570 Timberlea Blvd.
Mississauga, Ontario
Canada L4W-4M6
Tel: 905-629-7777
Fax: 905-629-7785

Cascade do Brasil
Praça Salvador Rosa,
131/141-Jordanópolis, 
São Bernardo do Campo - SP
CEP 09891-430
Tel: 55-13-2105-8800
Fax: 55-13-2105-8899

EUROPE-AFRICA
Cascade Italia S.R.L.
European Headquarters
Via Dell’Artigianato 1
37030 Vago di Lavagno (VR) 
Italy
Tel: 39-045-8989111
Fax: 39-045-8989160

Cascade (Africa) Pty. Ltd.
PO Box 625, Isando 1600
60A Steel Road
Sparton, Kempton Park
South Africa
Tel: 27-11-975-9240
Fax: 27-11-394-1147

ASIA-PACIFIC
Cascade Japan Ltd.
2-23, 2-Chome,
Kukuchi Nishimachi
Amagasaki, Hyogo 
Japan, 661-0978
Tel: 81-6-6420-9771
Fax: 81-6-6420-9777

Cascade Korea
121B 9L Namdong Ind. 
Complex, 691-8 Gojan-Dong
Namdong-Ku
Inchon, Korea
Tel:  +82-32-821-2051
Fax: +82-32-821-2055

Cascade-Xiamen
No. 668 Yangguang Rd.	
Xinyang Industrial Zone
Haicang, Xiamen City
Fujian Province
P.R. China 361026
Tel:  86-592-651-2500
Fax: 86-592-651-2571

Cascade India Material 
Handling Private Limited
Office No.21, 3rd Floor, 
Lokmanya House, 
Plot No.44, Sr. No. 89/90, 
CTS No.950, 
Lokmanya Colony, Paud Rd., 
Kothrud, Pune-411038 
Phone : +91 955 250 3060

Cascade Australia Pty. Ltd.
1445 Ipswich Road
Rocklea, QLD 4107
Australia
Tel: 1-800-227-223
Fax: +61 7 3373-7333

Cascade New Zealand
15 Ra Ora Drive
East Tamaki, Auckland
New Zealand
Tel: +64-9-273-9136
Fax: +64-9-273-9137

Sunstream Industries
Pte. Ltd.
18 Tuas South Street 5
Singapore 637796
Tel:  +65-6795-7555
Fax: +65-6863-1368
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